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サイプレスはインフィニオン テクノロジーズになりました
この表紙に続く文書には「サイプレス」と表記されていますが、これは同社が最初にこ
の製品を開発したからです。新規および既存のお客様いずれに対しても、引き続きイン
フィニオンがラインアップの一部として当該製品をご提供いたします。

文書の内容の継続性
下記製品がインフィニオンの製品ラインアップの一部として提供されたとしても、それ
を理由としてこの文書に変更が加わることはありません。今後も適宜改訂は行います
が、変更があった場合は文書の履歴ページでお知らせします。
 
注文時の部品番号の継続性
インフィニオンは既存の部品番号を引き続きサポートします。ご注文の際は、データシー
ト記載の注文部品番号をこれまで通りご利用下さい。
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さらにコード用例をお求めでしょうか？以下のとおりご対応いたします。 

常に成長する数百もの PSoC のコード用例のリストにアクセスするには、サンプルコードのウェブページ

をご覧ください。PSoCのビデオ ライブラリについてはここからご覧ください。 

AN211293 は、PSoC®アナログ コプロセッサについて紹介し、はじめての設計についてご案内します。PSoC アナログ 

コプロセッサは、アナログ フロント エンド (AFE)、信号処理エンジンを有する ADCおよび DAC、およびホスト プロセッサとの

通信インターフェースからなるシングル チップ ソリューションです。本アプリケーション ノートは、学習を加速するための追加 

リソースの概要を提供します。 
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1 はじめに 

PSoC アナログ コプロセッサは、プログラム可能なアナログ フロント エンド (AFE) を統合するスケーラブルかつ再構成可能

なアーキテクチャを提供することによって、センサーベース システムの設計を簡素化します。信号処理エンジン (32 ビット

Arm®Cortex®-M0+）は、ソフトウェアで AFEを校正し、調整できます。 

さらに、PSoC アナログ コプロセッサは、集められた処理前のフォーマット化されたセンサー データを、シリアル通信インター

フェースを介してホストプロセッサに送信する設計を可能にします。 

アナログ センサーは一般的に出力電気信号に応じて、電圧、電流、抵抗、静電容量またはインダクタンスの 5 種類が 

あります。それぞれのセンサー種類は特定の AFE設計を必要とします。以下のような場合です。 

▪ 熱電対 (電圧出力の温度センサー) は計測用アンプを必要とします 

▪ 環境光センサー (電流出力センサー) はトランスインピーダンス アンプ (TIA) を必要とします 

複数のアナログ センサーを使用するシステムは、一般的に AFEを実装するために複数の特殊 ICを必要とし、BOMコストと

PCB サイズを増加させます。IoT アプリケーション用に設計されるシステムは、複数のセンサーからのデータを結合して新た

なセンス機能を可能にします。これは、センサー フュージョンとして知られています。センサー フュージョンのソリューションは、

しばしばカスタム AFEを必要とします。PSoCアナログ コプロセッサは、特殊 ICの必要性を低減し、シングルチップ ソリュー

ションでカスタム AFEを作成する機能を提供します。 

図 1はセンサー ベース システムの一般的なブロック図を示します。それは以下のものを含んでいます。 

1. 信号を増幅しフィルターすることによって、センサー出力を調整するためのアナログ フロント エンド (AFE) 

2. 調整されたセンサー出力をデジタル データに変換するためのアナログ-デジタル変換器 (ADC) またはコンパレータ 

(表示なし) 

3. センサー データをフォーマット化しホスト プロセッサに送信するための、シリアル通信インターフェースを有するプログラ

マブル信号処理エンジン 

図 1. センサーベース システム 

 

このアプリケーション ノートは PSoC アナログ コプロセッサの機能を紹介し、シンプルな設計をスタートさせます。設計は 

サイプレスの CY8CKIT-048キットのための、CE211283コード用例として入手可能です。 

関連アプリケーションノートとコード用例セクションは、迅速に理解できるように様々な資料を提供しています。これは

AN211294, AFE Implementation Using PSoC Analog Coprocessorなどの上級のアプリケーション ノートも含んでいます。 
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2 PSoC リソース 

サイプレスは、www.cypress.com に大量の情報データを掲載しており、ユーザーがデザインに対して適切な PSoC デバイス

を選択し、迅速かつ効率的にデバイスをデザインに統合する手助けをします。リソースの総合リストは KBA86521, How to 

Design with PSoC 3, PSoC 4, PSoC 5LP and PSoC Analog Coprocessor を参照してください。以下は簡略なリスト 

です。 

▪ 概要: PSoC Portfolio、PSoC Roadmap 

▪ 製品セレクター: PSoC 1、PSoC 3、PSoC 4、

PSoC 5LPまたは PSoC Analog Coprocessor。

また、PSoC Creator にはデバイス選択ツール

が含まれています。 

▪ データシートは PSoC 3、PSoC 4、PSoC 5LP

および PSoC アナログ コプロセッサ デバイス 

ファミリの電気的仕様を説明し、提供します。 

▪ CapSense®デザイン ガイド:PSoC 3、PSoC 4、

PSoC 5LPおよび PSoC Analog Coprocessor

デバイス ファミリを使用して、静電容量タッチ 

センシング  アプリケーションを設計する方法 

について説明します。 

▪ アプリケーション ノートおよびコード用例は、基本的な 

レベルから上級レベルまで、幅広いトピックを提供します。

多くのアプリケーション ノートはコード用例を含んでいます。 

▪ テクニカル リファレンス マニュアル (TRM) は、PSoC 3、

PSoC 4、PSoC 5LPおよび PSoCアナログ コプロセッサ 

デバイス ファミリのそれぞれにおける、アーキテクチャお

よびレジスタの詳細な説明を提供します。 

▪ 開発キット: CY8CKIT-048 PSoC アナログ コプロセッサ

Pioneer Kitは安価で使い易い開発プラットフォームです。

このキットはスタンドアロン キットとしてまたは Arduino 

シールドとして機能します。 

3 PSoC Creator 

PSoC CreatorはWindowsベースの無料の統合開発環境 (IDE) です。これにより、PSoC 3、PSoC 4、PSoC 5LPおよび

PSoC アナログ コプロセッサに基づく、システムのハードウェアとファームウェアの同時設計が可能です。図 2 に示すように、

PSoC Creatorにより以下のことが可能です。 

1. コンポーネントをドラッグ アンド ドロップして、 

メイン デザイン ワークスペースでハードウェア

システム デザインを構築 

2. PSoC ハードウェアとアプリケーション ファーム

ウェアを同時設計 

3. コンフィギュレーション ツールを用いてコンポーネントを 

構成 

4. 100以上のコンポーネントを含むライブラリを利用 

5. コンポーネント データシートをレビュー 

http://www.cypress.com/
http://www.cypress.com/
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/knowledge-base-article/how-design-psoc-3-psoc-4-and-psoc-5lp-kba86521
http://www.cypress.com/psoc
http://www.cypress.com/product-roadmaps/cypress-psoc-and-mcu-portfolio-roadmap
http://www.cypress.com/products/psoc-1
http://www.cypress.com/search/psg/1292
http://www.cypress.com/search/psg/1297
http://www.cypress.com/search/psg/1307
http://www.cypress.com/products/psoc-analog-coprocessor
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A575
http://www.cypress.com/documentation/application-notes/an75400-psoc-3-and-psoc-5lp-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an75400-psoc-3-and-psoc-5lp-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A574
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A579
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Atechnical_documents&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=resource_meta_type%3A583
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A577
http://www.cypress.com/CY8CKIT-048
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
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図 2. PSoC Creatorの特長 

 

3.1 PSoC Creatorヘルプ 

PSoC Creator ホームページへアクセスし、PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を 

起動して以下のアイテムへナビゲートします。 

▪ クイック スタート ガイド: Help > Documentation > Quick Start Guide を選択します。このガイドは PSoC Creator 

プロジェクトを開発するための基礎知識を提供します。 

▪ システム リファレンス ガイド: Help > System Reference > System Reference Guideを選択します。このガイドは、

PSoC Creatorが提供するシステム機能を記載し説明します。 

▪ コンポーネント データシート: コンポーネントを右クリックして「Open Datasheet」を選択します。すべての PSoCアナログ 

コプロセッサのコンポーネント データシートの一覧については、PSoC Analog Coprocessor Component Datasheets 

ページをアクセスしてください。 

▪ ドキュメント マネージャー: PSoC Creator は、ドキュメント リソースを容易に見つけレビューするのを助けるために、

Document managerを提供します。Document Managerを開くには、メニューから Help > Document Managerを選択

します。 

3.2 テクニカル サポート 

ご質問には弊社のテクニカル サポート チームが対応させて頂きますので、お気軽にご連絡ください。Cypress Technical 

Supportページにアクセスし、サポート リクエストを作成してください。 

米国のお客様は、テクニカル サポート チームに連絡する際、以下の電話番号 (通話無料) にお問い合わせください: +1-800-

541-4736 プロンプトでオプション「8」を選択してください。 

早急な対応が求められる場合には、下記の方法をご利用ください。 

▪ セルフ ヘルプ 

▪ 各地の販売代理店 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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4 コード用例 

PSoC Creator は多数のコード用例プロジェクトを提供しています。 

これらのプロジェクトは、図 3に示すように、PSoC Creatorのスタート 

ページからアクセスできます。 

用例のプロジェクトにより、空のページではなく出来上がった設計を 

元に始めるため、設計時間を短縮できます。また、用例のプロジェクト

は PSoC Creatorコンポーネントを様々なアプリケーションに使用する

方法も示します。図 4 に示すように、コード用例、データシート 

(「Documentation」タブ) およびサンプル コードを含んでいます。 

図 4 に示す「Find Example Project」ダイアログには、いくつかの 

オプションがあります。 

▪ アーキテクチャまたはデバイス ファミリ (PSoC 3、PSoC 4、PSoC 

5LP または PSoC アナログ コプロセッサ) またはカテゴリやキー

ワードに基づいて用例をフィルターします。 

▪ Filter Optionsに基づいて提供された用例のリストから用例を選択

します。 

▪ 選択のためにデータシートをレビューします (「Documentation」

タブ上で)。 

▪ 選択のためにプロジェクトのコード用例をレビューします。この 

ウィンドウからコードをコピーし、プロジェクトに貼り付けてコード 

開発時間を短縮することができます。 

▪ 選択したものをベースに新規プロジェクト (また必要な場合は新規

ワークスペース) を作成できます。出来上がった基本的な設計を

元に始めることで設計時間を短縮します。その設計をユーザーの

アプリケーションに適用できます。 

図 3. PSoC Creatorのコード用例 

 

図 4. サンプル コードを含むコード用例プロジェクト 

 

http://www.cypress.com/
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5 PSoCアナログ コプロセッサの機能セット 

図 5に示すように、PSoCアナログ コプロセッサは、広範なアナログ機能セットおよびその他のリソースを持ちます。 

図 5. PSoCアナログ コプロセッサのブロック図 

 

以下は PSoC アナログ コプロセッサの主な機能の一覧です。詳細は、デバイス データシート、 テクニカル リファレンス  

マニュアル (TRM)、および関連アプリケーションノートとコード用例を参照してください。 

動作範囲および低消費電力モード 

• デバイスの動作電圧範囲: 1.71V～5.5V 

• スリープ モード (CPUへのクロック供給を切断)。

12MHzで標準電流 3.1mA 

• ディープスリープ モード (アナログが動作可能)。 

標準電流 2.5µA 

プログラマブル アナログ ブロック 

• 汎用アナログ ブロック (UAB) 

UABは以下のいずれか 1つに構成可能です。 

o 500kHz のサンプリング速度を持つ 12 ビット 

バッファ電圧 DAC (VDAC) 

o ローパス、ハイパス、バンドパスまたはノッチ 

フィルターなどの第 2次バイクアッド フィルター 

o 7.8Ksps のサンプリング速度および±1 LSB の

DNL 1を備える 12ビット デルタ シグマ ADC 

o 100sps のサンプリング速度および±2 LSB の

DNL を備える 14 ビット インクリメンタル デルタ  

シグマ ADC 1 

• 4個のプログラマブル オペアンプ 

o 90dB のオープンループ ゲイン、レイル ツー  

レイル動作 

o 標準のオペアンプ回路を形成するために、外部

コンポーネントと組み合わせて使用可能 

o 最大 32 のゲインがあるプログラム可能ゲイン 

アンプ  (PGA) を形成するために、内部抵抗 

アレイを使用可能 

o 外部 I/O 駆動時に 6MHz でのゲイン帯域幅 

(最大 10mA) 

o SAR ADC など内部ノード駆動時に 8MHz での

ゲイン帯域幅 

o ±1mVの入力オフセット電圧 

o 15µAのディープスリープ モード動作電流 

• 2個の低消費電力コンパレータ (CMP) 

o デバイスを低消費電力モードから復帰 

                                            
1 機能対応コンポーネントであり、2016年後半に提供する予定です。 
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• 12ビット SAR ADC 

o 最大 1Mspsのサンプリング速度 

o 選択可能な分解能: 8、10、または 12ビット 

o 16 入力チャネルを搭載する自動ハードウェア 

シーケンサー 

o 各チャネルは差動またはシングルエンドになる 

o チャネルごとに統合されたハードウェア平均化 

要素 

o 外部ピン、オペアンプ、および UAB などの 

プログラム可能な入力チャネル 

• シングル スロープ ADC 

o 選択可能な分解能: 8または 10ビット 

o サンプリング速度 : 最大 11.6ksps (10 ビット 

分解能) 

o 入力測定範囲: すべての GPIO ピンで VSS から

VDDAまで 

o CapSenseブロックに実装される 

• プログラマブル リファレンス ブロック (PRB) 

o VDDAから VSSまで、または 1.2V から VSSまでの

16 ステップで独立して調整可能な 4 つの基準 

電圧 

o 基準電圧は ADC、VDAC、コンパレータ、オペアン

プの内部高インピーダンス アナログ リソースに 

接続される 

o オペアンプを介してバッファリングされる場合、 

基準電圧は GPIOにも接続可能 

• CapSense® 

o 静電容量を測定 し 、 液体レベルやタ ッ チ  

センシング  アプリケーションなどの静電容量 

センサーと一緒に使用される 

o 自己容量および相互容量のセンシング方式 

o スペクトラム拡散クロックおよびプログラマブル ス

ルーレート制御を使用して電磁妨害 (EMI) を改善 

• IDAC 

o CapSense での使用または汎用アプリケーショ

ン用の 2個の 7ビット電流 DAC (IDAC) 

o 単一の 8 ビット IDACは 2個の IDAC を並行に

組み合わせることによって生成される 

o 正確な静電容量測定用の 37.5nA LSB電流 

o ソースまたはシンク  コンフィギュレーションの 

6つの出力電流範囲 (4.76µA～609µA) 

32ビットの信号処理エンジン 

• 最大 48MHzで動作する Arm Cortex-M0+ CPU 

• 読み出し加速装置を備えた最大 32KBのフラッシュ 

• 最大 4KBの SRAM 

• 8 チャネルのダイレクト  メモリ  アクセス  (DMA) 

コントローラー 

• リアルタイム クロック (RTC) アプリケーション用の 

時計水晶発振器 (WCO) 

• SPI、I2C、または UART に設定可能な 3 個のシリア

ル通信ブロック (SCB) 

• 8 個の 16 ビット タイマー／カウンター／パルス幅変

調器 (TCPWM) ブロック 

I/Oサブシステム 

• アナログ、デジタル、CapSense、またはセグメント

LCD機能のために使用される最大 38個の GPIO 

• プログラマブルな駆動モードおよびスルー レート 

• ピン信号で論理演算を実装できる 8個のスマート I/O 

5.1 PSoC Creator コンポーネントのコンセプト 

PSoC設計が成功するための鍵は PSoC Creator IDEです。PSoC Creatorでは、PSoCペリフェラルと他のリソースを「コン

ポーネント」と呼ばれる図式要素として要約します。コンポーネントは回路図にドラッグ＆ドロップされ、互いに接続されるため、

ハードウェア設計プロセスの段階を迅速かつ簡単にします。。設計変更は数回のマウス クリックだけですばやく行えます。 

以下のコンポーネントは、プログラマブルなアナログ ブロックを使用する設計のために提供されます。 

▪ プログラマブル ゲイン アンプ (PGA) およびオペアンプ 

▪ UABに実装される電圧 DAC (VDAC) 

▪ SAR ADCで実装される SAR ADCのスキャン 

▪ PRBに実装されるプログラマブル Vref (PVref) 

▪ シングル スロープ ADCで実装される CapSense ADC 

http://www.cypress.com/
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各コンポーネントにはデータシートがあります。コンポーネントの詳細はそのデータシートを参照してください。すべての PSoC

アナログ  コプロセッサのコンポーネント  データシートの一覧については、PSoC Analog Coprocessor Component 

Datasheetsページへアクセスしてください。 

http://www.cypress.com/
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
http://www.cypress.com/search/all?f%5b0%5d=meta_type%3Asoftware_tools&f%5b1%5d=field_related_products%3A1277&f%5b2%5d=software_tools_meta_type%3A532
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6 はじめての PSoCアナログ コプロセッサの設計 

このセクションは、簡単なセンサー ベース AFE の設計をビルドし、その設計を開発キットにプログラムするのに役立ちます。

PSoC Creator IDEを使用する PSoC設計技術の学習を容易にする詳細な手順を示します。 

6.1 始める前に準備するもの 

6.1.1 PSoC Creator をインストールしましたか？  

PSoC Creator ホームページから PSoC Creator をダウンロードし、インストールします。PSoC Creator 3.3 SP2 以降で

PSoCアナログ コプロセッサ ファミリをサポートします。 

6.1.2 開発キットを持っていますか？  

この設計は CY8CKIT-048 PSoC アナログ コプロセッサ Pioneer Kit のために開発されます。このキットは、Arduino™ 

シールドおよびベースボードとのフットプリント互換性をサポートしています。これは、1個の RGB LED、2個のプッシュ ボタン

スイッチ、1 個のサイプレス F-RAM™および基板搭載プログラマ／デバッガーおよび USB-UART/I2C ブリッジの 1 個の

KitProg2という 5個の基板搭載センサーを搭載しています。 

6.1.3 実行中のプロジェクトをご覧になりたいですか？  

設計の行程を追う必要がない場合は、http://www.cypress.com/CE211283 において、完成したコード用例プロジェクトを 

取得できます。そして、ビルドおよびプログラムのステップへ進めます。 

6.2 設計について 

この設計は、環境光センサー用のシンプルなアナログ調整回路を実装します。環境光センサーからの出力は、環境光の照度

に比例した弱い電流信号です。図 6は、この電流信号を調整し測定するための PSoC Creator回路図を示します。  

図 6. 最初の PSoCアナログ コプロセッサの設計 

 

環境光センサーからの電流出力は、1個のオペアンプと外部受動素子からなるトランスインピーダンス アンプ (TIA) を介して、

電圧信号に変換されます。TIA のリファレンス電圧は PRB ブロックで 1.20V に設定されます。TIA の出力は、12 ビット SAR 

ADC を使用して測定され、環境光の 0～1Klux の照度範囲の割合に応じて校正されます。この比率は、PWM のデューティ

比として用いられます。PWMの出力に接続された LEDは、環境光の照度に比例する明るさの変化を示します。 

注: CY8CKIT-048 PSoCアナログ コプロセッサ Pioneer Kitは、必要な環境光センサーを基板上に搭載し、PSoCアナログ 

コプロセッサに接続されています。追加コンポーネントは、設計をテストするために必要ありません。 

http://www.cypress.com/
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/CY8CKIT-048
http://www.cypress.com/CE211283
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6.3 パート 1: 設計の作成 

このセクションは設計過程を順を追って説明します。ハードウェアとファームウェアの両方の設計エントリについて解説します。 

注: これらの手順では、ユーザーが PSoC Creator 3.3 SP2 以降を利用していることを前提にします。全体的な 

開発過程は、PSoC Creator の以降のバージョンでも同様ですが、いくつかのダイアログ ボックスが変更になることが

あります。 

1. 新しい PSoC Creatorプロジェクトを作成します。 

a. PSoC Creatorを起動します。 

b. 図 7に示すように、メニューから File > New > Projectを選択します。 

「Create Project」ウィンドウが開きます。 

図 7．新しい PSoC Creatorプロジェクトの作成 

 

2. 図 8に示すように、PSoC Analog Coprocessorをターゲット デバイスとして選択します。 

PSoC Creatorは、自動的に様々なプロジェクト オプションを特定の開発キットやターゲット デバイスに設定できるため、

開発時間を短縮できます。  

A. Target deviceをクリックします。 

B. プルダウン メニューでは、PSoC Analog Coprocessorを選択します。  

C. Nextをクリックします。 

PSoC Creatorは、PSoCアナログ コプロセッサ ファミリのデフォルト デバイスとして CY8C4A45LQI-483を選択します。

このデバイスは、CY8CKIT-048 PSoCアナログ コプロセッサ Pioneer Kitに装着されます。 

図 8. ターゲット デバイスの選択 

 

A 

B 

C 
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3. 図 9に示すように、「Empty Schematic」を選択します。  

A. Empty Schematicをクリックします。 

B. Nextをクリックします。 

C. 図 10に示すように、次のダイアログの Workspace nameにワークスペースの名前を入力します。1つのワークス

ペース名にいくつかのプロジェクトを格納できます。 

D. ワークスペースの Locationを指定します。 

E. Project name にプロジェクトの名前を入力します。プロジェクト名とワークスペース名は同じでも違っても 

構いません。 

F. Finishをクリックします。 

図 9. 回路図テンプレートの選択 

  

図 10. プロジェクトの命名および保存先 

  

A 

B 

C 

D 

E 

F 
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4. 図 11 に示すように、プロジェクトの回路図がデフォルトで開きます。ここでは、ハードウェア設計回路図が作成されます。

「Workspace Explorer」ウィンドウでの関連ファイル TopDesign.cysch に注目します。回路図が表示されない場合は、

このファイルをダブルクリックして回路図を開きます。 

図 11. 回路図 

 

5. ステップ 3 で「Empty Schematic」を選択したため、「Top Design」は空白になります。図 11 に示すように、 

コンポーネント カタログはウィンドウの右側にあります。コンポーネント  カタログが表示されなかったら、View > 

Component Catalogのメニューを選択してそれを開きます。ユーザーはここで、コンポーネントの配置を開始できます。 

6. 回路図にトランス  インピーダンス  アンプ  (TIA) を作成することから始めます。図 12 に示すように、 

コンポーネント カタログからオペアンプ コンポーネントを選択し、配置します (ドラッグ & ドロップ)。

「Analog」グループの「Amplifiers」サブグループ内のオペアンプ コンポーネントを見つけてください。 

図 12. オペアンプ コンポーネントの選択 

 

デフォルトでは、コンポーネントのインスタンス名は Opamp_1 になります。コンポーネントは、中電力設定などの 

デフォルト プロパティで設定されています。次のステップでは、このアプリケーションの設定を変更します。 

http://www.cypress.com/


  PSoC®アナログ コプロセッサ入門 

www.cypress.com 文書番号: 002-12471 Rev.*A 13 

7. 「Opamp Component」をダブルクリックして、それを設定します。図 13に示すとおりに、コンポーネントを設定します。 

A. コンポーネントに「Opamp_TIA」と名前をつけます。 

B. OpAmpモードが (デフォルト設定として) 選択されることを確認してください。 

C. オペアンプ出力をピンに接続するために、Output to pinオプションを有効にします。 

図 13 に示すように、各コンポーネントは、設定ウィンドウからアクセスできる関連のデータシートを持っています。 

コンポーネント データシートは、コンポーネントの設定、アプリケーション プログラミング インターフェース (API) および 

電気的仕様の詳細情報を提供します。 

残りの設定はそれぞれ初期値のままにしておきます。各設定の重要性を理解できるように、コンポーネント データシート

を参照してください。 

OKクリックして設定を保存し、ウィンドウを閉じます。 

図 13. オペアンプ コンポーネントの設定 

 

8. 同様に、図 14 に示すように、PVref のコンポーネント (「Component Catalog」の「Analog」グループにある) を配置し、 

そのパラメータを設定します。このコンポーネントは、TIA のリファレンスおよび SAR ADC の反転入力を 1.20V に 

設定します。 

A. コンポーネントに「PVref」と名前をつけます。 

B. 「Reference source」を Bandgap (V) 1.20に設定します (デフォルト)。 

C. 「Voltage reference」 (V) を 1.20 (tap 16) に設定します (デフォルト)。 

A 

B
V C 
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図 14. プログラマブルなリファレンスの設定 

  
9. 図 15 に示すように、オペアンプ  コンポーネント  (「Component Catalog」の「Analog」グループの「Amplifiers」 

サブグループにある) を配置し、そのパラメータを設定します。このコンポーネントは、PVref のコンポーネントによって 

生成されたリファレンス電圧をバッファリングするために使用されます。 

A. コンポーネントに「Opamp_Buffer」と名前をつけます。 

B. 「Mode」を Followerに設定します。 

図 15. Opamp_Bufferの設定 

 

A 

B 

C 

A 

B 
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10. 図 16に示すように、スキャン SAR ADC (「Component Catalog」の「Analog」グループの ADCサブグループにある) を

配置し、そのパラメータを設定します。 

A. コンポーネントに「ADC」と名前をつけます。 

B. 「Free-run scan rate (SPS)」を 1000に設定します。 

C. 「Vref select」を System bandgap voltage (1.200 V)に設定します。測定範囲は SAR ADC の反転入力での 

電圧に対して±1.2Vの相対的な値です。 

D. TIA出力のみが測定される必要があるため、「Number of channels」を 1に設定します。 

E. 「Input mode」を Differentialに設定します (デフォルト)。 

図 16．SAR ADCの設定 - 設定タブ 

 

A 

B 

C 

D 

E 
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11. Component Catalog の「Digital」グループの「Functions」サブグループにある PWM コンポーネントを配置します。 

このコンポーネントは、LEDを駆動するために使用されます。図 17に示すとおりにコンポーネントを設定します。 

A. コンポーネントに「PWM」と名前をつけます。 

B. 「Period value」を 100に設定します。これは、PWM出力デューティ比がパーセント (0～100%) で直接制御される

ことを可能にします。 

C. デューティ比 90%の初期出力のために「Compare」の値を 90 に設定します。この値は実行時にファームウェアで 

変更されます。 

PWM出力周波数は、次のステップで設定されるクロック入力に依存します。 

図 17. PWMコンポーネントの設定 

 

A 

B 

C 
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12. 「Component Catalog」の「System」グループにあるクロック コンポーネントを配置します。このコンポーネントは、PWM

コンポーネントへのクロックを駆動するために使用されます。図 18 に示すように、コンポーネントに「Clock」と名前をつけ、 

デフォルト周波数を 12MHz に設定します。上記のステップで PWM 周期を 100 に設定した場合、PWM の 

出力周波数は 120kHzになります。 

図 18. クロック コンポーネントの設定 

 

13. ピンの配置および設定 

まず、TIA 入力にピンを配置し、設定します。TIA 入力がアナログ入力であるため、Component Catalog 内の 

「Ports and Pins」グループにあるアナログ ピン コンポーネントを選択します。 

A. コンポーネントに「Pin_Sensor」と名前をつけます。 

B. External terminalを有効にします。これにより、外部 (オフチップ) のコンポーネントを配置し、接続できます。回路

図での外部コンポーネントは明確にするために含まれています。 設計に影響を与えません。 

図 19は Pin_Sensorの設定を示します。 

図 19. Pin_Sensorコンポーネントの設定 

 

次は、Pin_Sensor と同様に、TIA 出力に他のアナログ  ピン  コンポーネントを配置します。コンポーネントに

「Pin_TIAOutput」と名前をつけ、External terminalを有効にします。 

A 

B 
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LED を駆動するために、デジタル出力ピンを配置します。図 20 を示すように、ピンに「Pin_LED」と名前をつけ、

External terminalを有効にします。残りの設定はそれぞれ初期値のままにします。 

図 20. Pin_LEDの設定 

 

14. 前のステップで説明したように、オフチップ コンポーネントは回路図でオプションです。図 21 に示すように、これらの 

コンポーネントは「Component Catalog」の「Off-Chip」タブにあります。オフチップ コンポーネントを含みたいのであれば、

該当するコンポーネントを配置してそれらの値を表 1に示すように設定します。 

図 21. オフチップ コンポーネント 

 

表 1. ピンおよび外部コンポーネントのコンフィギュレーション 

コンポーネント 

コンポーネント カタログ  

タブ グループ 値 

フォトダイオード Off-Chip Diodes - 

抵抗 Off-Chip Passive 220K 

コンデンサ Off-Chip Passive 0.1µF 

抵抗 Off-Chip Passive 2.2K 

LED Off-Chip Diodes - 

Vdd Off-Chip Power - 

グランド Off-Chip Power - 
 

 

これで、コンポーネントの配置と設定が完了します。次のステップでは各コンポーネントを繋げます。 

15. ワイヤー ツールを選択します (図 22を参照して

ください) 

 (または簡単な方法として「w」を押しても可能)。 

図 6 に示すように、コンポーネントの端子を 

一緒に配線します。 

図 22．ワイヤー ツール 
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16. これで、ハードウェアの設計が完成しましたが、ピン  コンポーネントを物理ピンに接続させなければなりません。 

使用している開発キットの物理的なピンを選択します。 

A. Workspace Explore window (ワークスペース エクスプローラウィンドウ) では、My_First_Design.cydwrファイルを

ダブルクリックします。 

B. Pins タブを選択します。デザインに使用されるピンはリストに表示されます。 

C. 図 23に示すように、デザインに使用される各ピン コンポーネントの所望の物理的ピンを選択します。 

図 23. ピン配置 

 

CY8CKIT-048 PSoC アナログ コプロセッサ Pioneer Kit を使用している場合、ピンは表 2 のとおりに設定する必要が 

あります。 

表 2. CY8CKIT-048の場合の物理ピンの割り当て 

ピン コンポーネント名 物理ピン 

Pin_Sensor P2[4] 

Pin_TIAOutput P2[3] 

Pin_LED P1[4] 

 

17. ハードウェア構成の設定が終了した後、ファームウェア コードを追加します。しかし、そうする前に、PSoC 

Creator にコンポーネントと関連する API コードを生成させておくことが最善です。図 24 に示すように、Build> 

Generate Application を選択します。図 25 に示すように、エラーがなければ、 PSoC Creator は 

Generated_Source フォルダにいくつかのコード ファイルを生成します。 

A 

B 

C 
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図 24. アプリケーションの生成 

 

図 25に示すように、ワークスペースから自動生成したファイル main.cを開きます。 

図 25. 生成されたソース ファイル 
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コード 1のコードをユーザーのプロジェクトの main.cファイルに追加します。コードは以下のタスクを実行します。 

▪ Opamp_TIA_Start()などのコンポーネント API関数を使用してコンポーネントを初期化します。 

▪ ADC変換の結果を読み出し、フィルターします。 

▪ フィルターされた ADC変換結果をパーセントの値に変換します。 

▪ 計算されたパーセントで PWMデューティ比を更新します。 

コード 1. main.c 

#include <project.h> 

#include "stdio.h" 

 

/* IIR Filter Coefficient */ 

#define FILTER_COEFFICIENT_ALS 8 

 

/* ADC Channel for ALS - Channel 0 */ 

#define ALS_CHANNEL 0x00 

 

/* ADC Counts at 1K lux illuminance, calculated based on the sensor TEMD6200FX01 

datasheet */ 

#define ADCCOUNTS_1K_LUX 0x96 

 

int main() 

{ 

/* Variables */ 

int ADCResult, ADCFiltOut=0, ALSPercent; 

 

/* Enable global interrupt */ 

CyGlobalIntEnable;  

 

/* Start the TIA */ 

Opamp_TIA_Start(); 

 

/* Start the Reference Voltage */ 

PVref_Start(); 

 

/* Start the Opamp buffer */ 

Opamp_Buffer_Start(); 

 

/* Start the SAR ADC; continuous conversions */ 

ADC_Start(); 

ADC_StartConvert(); 

 

/* Start the PWM */ 

PWM_Start(); 

 

 for(;;) 

{ 

/* ADC scan rate is set to 1ksps */  

/* Check if the ADC result is ready */         

 if(ADC_IsEndConversion(ADC_RETURN_STATUS)) 

{ 

/* Get the sign extended 16 bit result with 11 bits of magnitude */ 

ADCResult = ADC_GetResult16(ALS_CHANNEL); 

             

/* IIR Filter - sample rate: 1 ksps */ 

/* Weight on the new sample is 1/8, and weight on the previous filter output is 

7/8 */ 

ADCFiltOut = (ADCResult + (FILTER_COEFFICIENT_ALS - 1) * ADCFiltOut) / 

FILTER_COEFFICIENT_ALS; 

 

/* Convert filtered data into percentage. Filter output is multiplied by -1, so 

that the percentage value is directly proportional to the ambient light 

illuminance */ 

http://www.cypress.com/
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ALSPercent = (-1*ADCFiltOut*100) / ADCCOUNTS_1K_LUX; 

 

/* Limit the values between 0 to 100 to express the ambient light  

illuminance in percentage for a given operating window (0 to 1 Klux)*/ 

ALSPercent = (ALSPercent > 100) ? 100 : ((ALSPercent < 0) ? 0 : ALSPercent); 

 

/* Update PWM duty cycle. The LED has an active low connection on the CY8CKIT-048 

kit. */ 

PWM_WriteCompare(PWM_PWM_PERIOD_VALUE - ALSPercent); 

} 

} 

} 

 
18. 設計過程を飛ばしてこのステップに進んだ場合、以下のようにしてください。 

A. CE211283.zip のコード用例のファイルを http://www.cypress.com/CE211283 からダウンロードし、コンピューター

の便利な位置に展開します。 

B. 6.1.1セクションで説明したように、PSoC Creatorをダウンロードし、インストールします。 

C. CE211283.cywrkファイルを開きます。 

D. プロジェクトのピンの割り当てがユーザーの開発キット (DVK) に一致するか否かを確認します。CY8CKIT-048 の 

場合は表 2を参照してください。 

E. 図 26 に示すように、Build > Build <プロジェクト名>を選択します。エラーがなければ、プロジェクトはビルドされ、

対象の DVKにプログラムできる状態になります。 

図 26. プロジェクトのビルド 
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6.4 パート 2: デバイスのプログラム 

1. DVKをユーザーのコンピューターの USBポートに接続します。 

2. PSoC Creator とユーザーの DVKの接続を確認します。これを行うためには、図 27に示すように、まず PSoC Creator

のメニューから「Debug > Select Debug Target」を選択します。  

図 27. デバッグ ターゲットの選択 

 

A. 図 28 に示すように、「Select Debug Target」ダイアログが表示されます。ターゲットの DVK をクリックします 

(PSoC Creatorは多くの DVK接続をサポートします) 。 

B. Port Acquireをクリックします。 

図 28. ターゲットの設定 

 

A 

B 
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3. ターゲットの DVK上の PSoCに接続します。図 29を参照してください。 

A. PSoC Analog Coprocessorをクリックします。 

B. Connect をクリックします。「Target unacquired」メッセージが「Target acquired」になり、ボタンのラベルは

「Disconnect」に変わります。 

C. OKをクリックしてダイアログを閉じます。 

これで、PSoC Creator はターゲットの DVK と PSoC に接続され、PSoC デバイスをプログラムすることが可能に 

なります。 

図 29. PSoCアナログ コプロセッサに接続 

 

4. PSoCアナログ コプロセッサをプログラムするために、図 30に示すように Debug > Programを選択します。 

図 30. PSoCプログラミング 

 

A 

B 

C 
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5. プログラミングが始まります。図 31 に示すように、プログラミング状況は PSoC Creator のステータス バー (画面の 

左下隅) に表示されます。 

注: 「This programmer is currently out of date」の警告メッセージが表示される場合があります。プログラマ 

ファームウェアをアップグレードする方法は、キットの資料にある KitProgユーザー ガイドを参照してください。 

図 31. プログラミングの状態 

 

6.5 パート 3: 設計のテスト 

以下の各ステップを実行して設計をテストします。 

1. 図 32に示すように、CY8CKIT-048 DVKの USBポートを PCに接続します。 

図 32. CY8CKIT-048 DVK 

 

2. 環境光センサー (ALS) の上に手を移動し、それに応じて赤色 LED の輝度も変化することを観察してください。十分な 

環境光がある場所へのテスト環境の移動が必要な場合があります。 

7 まとめ 

本アプリケーションノートは、PSoC アナログ コプロセッサ デバイスを紹介し、ユーザーのはじめての設計を作成するのに 

役立ちます。また、本アプリケーション ノートは、迅速に理解できるように追加リソースの概要を説明しました。 

ALS 

LED 

http://www.cypress.com/
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8 関連アプリケーションノートとコード用例 

表 3に、PSoC と PSoC Creatorの学習の次段階に推奨される選択されたシステム レベルおよび一般的なアプリケーション 

ノートを示します。 

表 3. 一般的なシステム レベルのアプリケーション ノート 

文書番号 文書名 

AN86233 PSoC 4 and PSoC Analog Coprocessor Low-Power Modes and Power Reduction Techniques 

AN88619 PSoC 4 Hardware Design Considerations 

AN73854 PSoC 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders 

AN89056 PSoC 4 – IEC 60730 Class B and IEC 61508 SIL Safety Software Library 

 

表 4はデバイスの特定ペリフェラルおよびアプリケーションのアプリケーション ノート (AN) およびコード用例 (CE) を示します。 

表 4. PSoCアナログ コプロセッサ機能に関連する資料 

文書番号 文書名 

プログラマブル アナログ 

AN211294 AFE Implementation Using PSoC Analog Coprocessor 

AN60590 PSoC 3, PSoC 4 and PSoC 5LP - Temperature Measurement with a Diode 

AN70698 PSoC 3, PSoC 4 and PSoC 5LP – Temperature Measurement with an RTD 

AN66477 PSoC 3, PSoC 4 and PSoC 5LP – Temperature Measurement with a Thermistor  

CE211252 Interfacing PSoC Analog Coprocessor with Ambient Light Sensor 

CE211301 Interfacing PSoC Analog Coprocessor with PIR Motion Sensor 

CE211305 Interfacing PSoC Analog Coprocessor withInductive Proximity Sensor 

CE211321 Interfacing PSoC Analog Coprocessor withThermistor 

CE211322 Interfacing PSoC Analog Coprocessor with Humidity Sensor  

CPUおよび割り込み 

AN89610 PSoC 4 and PSoC 5LP ARM Cortex Code Optimization 

AN90799 PSoC 4 Interrupts 

I/O 

AN86439 PSoC 4 and PSoC Analog Coprocessor - Using GPIO Pins 

CapSense 

AN85951 PSoC 4 and PSoC Analog Coprocessor CapSense® Design Guide 

AN92239 Proximity Sensing with CapSense 

ブートローダ 

AN86526 PSoC 4 and PSoC Analog Coprocessor I2C Bootloader 

AN68272 PSoC 3, PSoC 4, PSoC 5LP and PSoCAnalog Coprocessor UART Bootloader 

セグメント LCD 

AN87391 PSoC 4 Segment LCD Drive 

プログラミング 

AN84858 PSoC 4 Programming Using an External Microcontroller (HSSP) 
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http://www.cypress.com/documentation/application-notes/an88619-psoc-4-hardware-design-considerations?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an73854-psoc-3-psoc-4-and-psoc-5lp-introduction-bootloaders?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an89056-psoc-4-iec-60730-class-b-and-iec-61508-sil-safety-software?source=search&cat=technical_documents
http://www.cypress.com/an211294
http://www.cypress.com/documentation/application-notes/an60590-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement-diode
http://www.cypress.com/documentation/application-notes/an70698-psoc-3-psoc-4-and-psoc-5lp-temperature-measurement-rtd
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http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an92239-proximity-sensing-capsense
http://www.cypress.com/documentation/application-notes/an86526-psoc-4-i2c-bootloader?source=search&cat=technical_documents
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